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Preface 
This guide clearly and concisely sets out the information developers need to know to get started with 
the CASIO DT-X30 series handheld terminals with the integrated Windows® CE OS development. 
The best methods of connecting to your development system are covered and step by step 
instructions for installing and testing the CASIO BDKs are included. 
 
The purpose of this guide is to get you to the point where you can start development; you should 
refer to the library manuals for detailed information on the specific APIs. 
 
For DT-X30 series handheld terminals with the integrated Windows Mobile® OS, see DT-X30WM 
Quick Start Guide available separately. 
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1. Product Overview 

1.1 Features at a Glance 
The DT-X30 has been designed using the new concept of the Human-centered Design Processes and 
is capable of performing a wide variety of powerful functions. 
The following is a brief overview of the features available on the DT-X30 series handheld terminals. 
For further detail on the hardware specifications, refer to DT-X30 Series Hardware Manual. 
 
Outstanding development environment  
• Microsoft® Windows® CE 6.0 English Version as the built-in OS 
• Visual Studio 2008 
• Visual Studio 2005 

 
Capability of various communication systems 
• Built-in ultra-small WLAN module compatible with the IEEE802.11b/g standard 
• Built-in WWAN module combines GSM, GPRS and EDGE modules with GPS receiver 

designed for use in transportation and logistics. 
• High speed infrared communication with IrDA Ver. 1.3 
• Bluetooth® Version 2.0 
• Serial interface with USB version 1.1 (Host/Client) 

 
Small size, light weight 
• Dimensions : Approx. 87 (W) x 242 (D) x 46 (H) mm 
• Weight  : Approx. 550 g 

 
Improved durability 
• Impact resistance   : 1.8 m in height * 
• Dust/Water-splash proof : IP67 level (compliant with IEC60529 International Standard) 

 
Capable of scanning industrial standard bar code symbologies 
• Readable bar code symbologies: 

UPC-A/E, EAN8, EAN13, Codabar, Code39, Code93, Code128/GS1-128, ITF, MSI, IATA, 
GS1 DataBar Omnidirectional, GS1 DataBar Limited, GS1 DataBar Expanded, GS1 DataBar 
Stacked, GS1 DataBar Expanded Stacked 

 
CPU, Memory 
• High-performance CPU 

Marvell® PXA320 Application Processor (runs at maximum 624 MHz) 
• Large-capacity memory 

RAM : 128 MB 
F-ROM : 128 MB (user area; approximately 60 MB) 

 
 
* The drop durability height is a measured value resulting from actual testing. It does not necessarily guarantee the 

product from damage. 
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1.2 Library Configuration 
The DT-X30 Software Development Kit (“BDK”) provides various libraries including those listed in 
the table. 
 
Table 1.1 

Library Description C++ VB
C# 

System Library Library that is used to control the system. Yes Yes
Laser Scanner Library Library that is used to control the built-in laser scan engine. Yes Yes
Bluetooth Library Library that is used to control the built-in Bluetooth module. Yes Yes
Camera Library Library that is used to control the built-in Camera module. Yes Yes
Imager Library Library that is used to control the built-in CMOS Imager. Yes Yes
WANGPRS Library Library that is used to control the built-in WANGPRS module. Yes Yes
JPEG Library Library that is used to handle and manipulate JPEG image 

functions. 
Yes - 

FLINK Library Library that is used to control and carry out transmission/reception 
of files between PC and other device. 

Yes Yes

Note: 
The abbreviations used in the table are; 

C++ : Visual C++ 
VB : Visual Basic .NET 
C# : Visual C# .NET 

 
 
Table 1.2 shows each file name of the Dynamic Link Library and Dynamic Link Class Library. 
 
Table 1.2 

Library Dynamic Link Library Dynamic Link Library 
(Class Library) 

Common Device Control Library   
System Library SystemLib.dll SystemLibNet.dll 
Laser Scanner Library OBReadLib.dll OBReadLibNet.dll 
Bluetooth Library BluetoothLib.dll BluetoothLibNet.dll 
Camera Library CameraLib.dll CameraLibNet.dll 
Imager Library ImagerLib.dll ImagerLibNet.dll 

 

WANGPRS Library WangprsLib.dll WangprsLibNet.dll 
JPEG Library JpegCe.dll None 
FLINK Library FlinkLib.dll MoFlinkLib.dll 
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1.3 Development Manuals 
The DT-X30 Software Development Kit (“BDK”) provides various development reference manuals 
as described in the table below. 
 
Table 1.3 

Development Manual Description 
Quick Start Guide (See note 1) This reference manual. 
Software Manual (See note 1) Reference manual that describes software specifications in detail for all 

the software integrated in DT-X30 handheld terminal. 
Hardware Manual (See note 2) Reference manual that describes hardware specifications in detail on 

each dedicated option and DT-X30 handheld terminal 
System Library Manual Reference manual that describes individual functions in detail for System 

Library. 
Laser Scanner Library Manual Reference manual that describes individual functions in detail for Laser 

Scanner Library. 
Bluetooth Library Manual Reference manual that describes individual functions in detail for 

Bluetooth Library. 
Camera Library Manual Reference manual that describes individual functions in detail for 

Camera Library. 
Imager Library Manual Reference manual that describes individual functions in detail for Imager 

Library. 
WANGPRS Library Manual Reference manual that describes individual functions in detail for 

WANGPRS Library. 
JPEG Library Manual Reference manual that describes individual functions in detail for JPEG 

Library. 
FLINK Library Manual Reference manual that describes individual functions in detail for FLINK 

Library. 
Notes: 
1. The dedicated quick start guide for models with the integrated Windows CE OS. 
2. The hardware reference manual for models with the integrated Windows CE OS or with the 

Windows Mobile OS. 
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1.4 Sample Program 
The following sample programs are included in the DT-X30 Export BDK. 
 
Table 1.4 

Sample Program Description 
Common Device Control Library 

BLUETOOTHLIBSAMPLE Connects the terminal to a Bluetooth printer and prints out data. 
CAMERALIBSAMPLE Takes pictures and displays them on the screen. 
IMGLIBSAMPLE Scans bar codes using the Imager with settings set with Imager setting 

file. 
IMGLIBSAMPLE2 Program of IMGDemo.exe 
OBRLIBSAMPLE Reads a bar code using the Laser library. 
PRNLIBSAMPLE Prints out data on the built-in printer. See note 2. 

 

SYSTEMLIBSAMPLE Demonstrates LED and buzzer functions. 
WANGPRS Library 
 GPRS_TUTORIAL Demonstrates GPRS communication. 
JPEG Library 
 JPEGSAMPLE Displays Jpeg files. 
FLINK Library 

 FLINKLIBSAMPLE Demonstrate infrared communication via FLINK protocol between two 
terminals. 

High resolution signature 
 HIRESOLUTION Demonstrates how to capture high resolution signature. 

Notes: 
1. Two-character abbreviation showing the respective development platforms is added at the end 

of each folder name. 
VC : Visual C++ 
VB : Visual Basic .NET 
CS : Visual C# .NET 

 
2. Some of the sample programs such as PRNLIBSAMPLE in the table do not run because the 

respective devices are not integrated in the DT-X30 terminal. 
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2. Prerequisites 

2.1 Skills Required 
The following skills are required by developers aiming to develop application software for the 
DT-X30 terminal. 
• Windows programming 
• A good knowledge of one or more of the following 

- Visual C++ 
- Visual Basic .NET 
- Visual C# .NET 
- Browser based applications (not covered in this guide) 

 
The following skills or experience are also desirable. 
• Windows CE devices 
• ActiveSync 
• Some networking experience 
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2.2 Hardware Required 
The following models of the DT-X30 series and dedicated options are available. 
 
Table 2.1  List of available models 

Model no. Scanner WLAN 
(802.11 b/g)

WWAN 
(GSM, GPRS,  

EGPRS) 
GPS Bluetooth Camera 

DT-X30R-10 Laser Yes No No Yes No 
DT-X30G-10-CN Laser No Yes Yes Yes No 
DT-X30GR-10 Laser Yes Yes Yes Yes No 
DT-X30GR-10C Laser Yes Yes Yes Yes Yes 
DT-X30R-30 Imager Yes No No Yes No 
DT-X30R-30-CN Imager Yes No No Yes No 
DT-X30GR-30 Imager Yes Yes Yes Yes No 
DT-X30GR-30-CN Imager Yes Yes Yes Yes No 
DT-X30GR-30C Imager Yes Yes Yes Yes Yes 
DT-X30GR-30C-CN Imager Yes Yes Yes Yes Yes 

DT-X30R-50 Full Range 
Imager 

Yes No No Yes No 

DT-X30R-50C Full Range 
Imager 

Yes No No Yes Yes 

 
Table 2.2  List of the dedicated options 

Option Product Model no. Remark 
HA-G60IO  USB Cradle 
HA-G60IO-CN  
HA-G62IO  

Cradle 

Ethernet Cradle 
HA-G62IO-CN  
HA-G20BAT  Battery  Battery Pack 
HA-G20BAT-CN  
HA-G32DCHG  Dual Battery Charger 
HA-G32DCHG-CN  
HA-G30CHG  Cradle-type Battery Charger 
HA-G30CHG-CN  
HA-G35CHG  

Battery charger

Car Mounted-type Battery 
Charger HA-G35CHG-CN  

AD-S42120B AC adaptor 
AD-S42120B-CN 

For HA-G60IO, HA-G62IO, 
HA-G30CHG, HA-G32DCHG 

AC-CORD-EU For Europe 
AC-CORD-US For USA/Canada 
AC-CORD-TW For Taiwan 
AC-CORD-KR For Korea 

Power Cable for AD-S42120B 

AC-CORD-AU For Australia/New Zealand 
Cable USB cable DT-380USB For cradle - PC 
Others Screen Protect Sheet HA-G90PS5  

Note: 
“-CN” attached at the end of model number in Tables 2.1 and 2.2 denotes that the model is dedicated 
for the final destination of China. A note about compliance with the Chinese “RoHS” requirement 
promulgated by the Ministerial Decree No. 39 is included in the carton box; the RoHS compliant 
seal is affixed on the body and the seal of the packing material recycle marking is affixed on the 
carton box. 
See the following pages for DT-X30 terminal external views and the dedicated options. 
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External views of the DT-X30 and the dedicated options 
 

 
Figure 2.1 
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Figure 2.2 

13

 

 



 

 

2.3 Software Required 
PC Operating System 
• Microsoft Windows 2000 Professional Service Pack 4 or later 
• Or Microsoft Windows 2000 Server Service Pack 4 or later 
• Or Microsoft Windows XP Professional Service Pack 2 or later 
• Or Microsoft Windows 2003 Server Service Pack 1 or later 
• Or Microsoft Windows Vista (Business / Ultimate ) 
• Or Microsoft Windows 7 
• Or Microsoft Windows Server 2008 

 
Development platform 
The following software tools and libraries are required in order to develop software for the DT-X30. 
Please ensure that you download or purchase the correct Microsoft tools as appropriate. 
 
• Microsoft Visual Studio 2008 (not free of charge) 
• Microsoft Visual Studio 2005 + Service Pack 1 (not free of charge) 
• Microsoft ActiveSync 4.2 (or later) 

Download for free from; 
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

• Microsoft Windows Mobile Device Center 6.1 (for Windows Vista) 
Download for free from; 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F
07AAA1914&displaylang=en 

 
CASIO DT-X30 BDK 

Download the DT-X30 BDK from; 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by CASIO.) 
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3. Installing BDK to PC 

3.1 Application Development 
This chapter explains about what you need to set up for the development environment before 
starting your application development. 
 
1. Installing Development Platform 

Install Microsoft’s development platform which supports Visual Studio 2008 and Visual Studio 
2005. For detail, refer to Chapter 2.3 “Software Required”. 

 
2. Installing CASIO BDK to PC 

Install Casio’s BDK (“Basic Development Kit”) and various libraries if necessary. For 
installation method, refer to Chapter 3.2 “Installing CASIO BDK Files”. 

 
3. Connecting DT-X30 to PC (via either ActiveSync or Windows Mobile Device Center) 

Connect the DT-X30 to PC via Microsoft’s ActiveSync (for Windows XP or any other OS before 
Windows XP) or via Windows Mobile Device Center (for Windows Vista or later). For 
connection method, refer to Chapter 5 “Connecting the DT-X30 to PC”. 

 
4. Setting up the Development Environment 

Transmit the Casio’s libraries to the DT-X30. 
For detail, refer to Chapter 6 “Setting Up the Development Environment”. 

 
5. Installing the Device Emulator 

Install the Device Emulator for the DT-X30. For installation method, refer to Chapter 7 “Device 
Emulator”. If not necessary to install, go to “6. Application Development” below. 

 
6. Application Development 

Now, the application development environment is set up and your development with the 
development platform can be started. After application is developed, transfer it to the Device 
Emulator or an actual terminal of the DT-X30 via ActiveSync or Windows Mobile Device Center 
for check on the operability. For application development method and transferring your 
application, refer to Chapter 8 “Visual Studio”. 

15 



 

 

3.2 Installing CASIO BDK Files 
Download the CASIO DT-X30 BDK installation CD image file from the following site and write it 
to a CD-ROM media. 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by CASIO.) 

 
Notes: 
• If you had already installed DT-X30 BDK Ver. 1.xx, be sure to uninstall it before installing Ver. 

2.xx. 
• If any file of the DT-X30 BDK Ver. 1.xx is remained in the following folders after uninstalling, 

delete it manually. 
C:\Program Files\CASIO\MBSYS 
C:\Program Files\Windows CE Tools\wce500 

• If your PC runs in the Windows Vista or later OS, first you must disable the User Account 
Control (“UAC”) by following the process below before installing the CASIO BDK Files. 

 
  Case of using Windows Vista and Windows Server 2008 

- Navigate to Control Panel → User Accounts → Enable or Disable the User 
Account Control. Remove the check on User Account Control (UAC) to protect 
your PC, and then click OK button. 

 
  Case of using Windows 7 

- Navigate to Control Panel → User Accounts → Change User Account Control 
Settings.  Select Never notify in Choose when to be notified about changed to your 
computer setting. 
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Installing ExportBDK 
1. When the CASIO DT-X30 BDK CD-ROM is inserted in the drive of PC, the following menu 

screen appears automatically. 

 
Figure 3.1 

 
2. Click Installation List in Figure 3.1. The installation screen appears. 

 
Figure 3.2 
 
3. Click DT-X30 ExportSDK to display the Setup Wizard. Choose any one of the buttons in the 

screen. 
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Installing Library 
The DT-X30 Library is available for the below development platforms. 
 
• Microsoft Visual Studio 2008 
• Microsoft Visual Studio 2005 

 
Notes: 
1. The Library header file (*.h) and the Import library file (*.lib) are installed in the following 

folder. 
C:\Program Files\CASIO\MBSYS\include : Header file 
C:\Program Files\CASIO\MBSYS\lib\ARMV4I : Import library file 

2. The Class library DLL file (*.dll) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\WindowsCE 

3. When the Library is installed in PC, the Help file (*.chm) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\HELP 
 

The Help file can be accessed by navigating to Start menu → All Programs → CASIO Basic 
Development Kit → Help. 

 
 

Installing Online Help 
Besides the Help file described above, the Online Help is also available for the below development 
platforms. The installation of the Online Help is initiated in the Installation List. 
 
• Microsoft Visual Studio 2008 
• Microsoft Visual Studio 2005 

 
After the installation is complete, Microsoft Visual Studio starts up. The Online Help file can be 
accessed by navigating to Help → Contents menu. 
 
 
Installing Sample Program 
When the Sample is chosen in the Installation List, the sample program folder in the CD-ROM 
appears on the screen. The Sample program folder is available for the development platforms below. 
Copy it into your PC. 
 
- VS2008 for Microsoft Visual Studio 2008 
- VS2005 for Microsoft Visual Studio 2005 
 
If your sample program is with "Read-only" attribute set effect. Be sure to disable the attribute 
before using it. 
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4. Connecting Power Supply to Cradle 

4.1 HA-G60IO 
Use the dedicated AC adaptor (AD-S42120B) for supplying power to the HA-G60IO USB Cradle. 
Ensure that you connect the AC adaptor to the cradle before starting communication between the 
DT-X30 and PC via the cradle. Follow the steps below to connect the power supply to the DT-X30 
using the dedicated AC adaptor. 
 
1. Plug the AC adaptor into the AC adaptor jack where “DCIN12V” is printed on the back of the 

cradle. 
2. After connecting the power cable to the AC adaptor, plug in the plug to an electrical outlet. 
3. Make sure the selector switch on the back of the cradle is set to position B. 
4. Connect a USB cable (DT-380USB) to the USB client port on the back of the cradle, and then 

connect the other end of the cable to the PC. USB host port is used when connecting the cradle 
with other USB peripheral devices. 

5. Align the USB cradle mount holes on the back of the DT-X30 with the mount hooks on the cradle 
after aligning the contacts on the bottom of the DT-X30 with the power contacts of the cradle. 
The power LED on the front of the cradle will light green if the DT-X30 has been properly 
mounted. 
 
Status of Indicator 1 on DT-X30 

Orange : Charging 
Red : Standby due to battery pack error or the surrounding temperature is out of the range (charging 

begins when the temperature returns within the correct range.) 
Green : Charging complete 

 
Notes: 
• Always remove the DT-X30 from the cradle when switching the selector switch on the cradle. 
• Never short the power contacts of the cradle. This damages the cradle. 
• Do not subject the DT-X30 and cradle to vibration or impact during communication. This results 

in communication being interrupted. 
• When mounting the DT-X30, securely attach it to the mount hooks of the cradle and check that 

the power LED on the front of the cradle lights green. Charging the battery pack or 
communication will not proceed if it is not mounted properly. 
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4.2 HA-G62IO 
Use the dedicated AC adaptor (AD-S42120B) for supplying power to the HA-G62IO Ethernet 
Cradle. Ensure that you connect the AC adaptor to the cradle before starting communication 
between the DT-X30 and PC via the cradle. Follow the steps below to connect the power supply to 
the DT-X30 using the dedicated AC adaptor. 
 
1. Plug the AC adaptor into the AC adaptor jack on the back of the Ethernet Cradle. 
2. After connecting the AC adaptor to the power cable, plug in the plug of the power cable to an 

electrical outlet. 
3. Set the selector switch on the back of the Ethernet cradle to the port that will be used. Set the 

switch to “LAN” to use the LAN port or to “USB” to use the USB port. 
4. Before using the cradle ports, remove the caps from the ports. When using a LAN, connect one 

end of the LAN cable to the LAN port and the other end to the PC or hub. When using a USB 
connection, connect one end of the USB cable (DT-380USB) to the USB port and the other end 
to the PC. 

5. Align the contacts on the underside of the DT-X30 with the power supply contacts on the 
Ethernet Cradle and then set the DT-X30 into the cradle so that mount holes in the back of the 
DT-X30 are aligned with the mount hooks on the cradle. Once the DT-X30 is properly set in the 
cradle, the power LED on the front of the Ethernet cradle lights green. 
 
Status of Indicator 1 on DT-X30 

Orange : Charging 
Red : Standby due to battery pack error or the surrounding temperature is out of range 

(charging begins when the temperature is within the correct range.) 
Green : Charging complete 

 
Notes: 
• Always remove the DT-X30 from the Ethernet Cradle before changing the selector switch 

setting. 
• Never short out the power contacts of the cradle. This damages the cradle. 
• Do not subject the DT-X30 and cradle to vibration or impact during communication. This results 

in communication being interrupted. 
• When mounting the DT-X30, securely attach it to the mount hooks of the cradle and check that 

the power LED on the front of the cradle lights green. Charging battery pack or communication 
will not proceed if it is not mounted properly. 

• The LAN and USB connections cannot be used concurrently. 
• Always cap ports that are not being used. Using the Ethernet Cradle while the ports are 

uncapped can cause damage. 
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5. Connecting the DT-X30 to PC 
To make connection establishment with PC, use one of the methods, depending on the OS your PC 
runs, described below. 
 
• ActiveSync (for Windows XP or any other OS earlier) 

Use the ActiveSync to connect the DT-X30 to PC if the PC runs in Windows XP or other OS 
earlier than Windows XP. The ActiveSync can be downloaded at the URL below. 
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

 
• Windows Mobile Device Center (for Windows Vista or later) 

Use the Windows Mobile Device Center to connect the DT-X30 to PC if the PC runs in 
Windows Vista OS. The Windows Mobile Device Center (“WMDC”) can be downloaded at the 
URL below. 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F
07AAA1914&displaylang=en 
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5.1 ActiveSync Connection via USB 
If you have already installed ActiveSync and connected the DT-X30 to the PC via direct USB, You 
may skip Chapter 5.1.1. You already have the USB driver and ActiveSync in your development 
environment. If you do not yet have the cradle driver on your PC, download the USB driver files 
“wceusbsh.inf” and “wceusbsh.sys” from the CASIO web site and copy them to an appropriate 
folder. 
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5.1.1 Installing ActiveSync for the First Time 
1. Install ActiveSync first. Run the ActiveSync ‘msi’ file. 

 
Figure 5.1 

 
2. Click Install button. 

 
Figure 5.2 
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3. Pause the installation when the menu in Figure 5.3 is displayed; you have to install the driver at 

this point. 

 
Figure 5.3 

 
4. Connect the USB cable to the PC and the other end to the USB Cradle and also the AC adaptor to 

the USB Cradle. 
5. Put the DT-X30 on the cradle and confirm that the green LED on the front of the cradle is lit. If 

not, be sure the DT-X30 is positioned firmly on the cradle. 
6. When the DT-X30 is mounted on the USB Cradle, a dialog is displayed to prompt you to install 

the suitable driver. If you have not yet obtained the driver files, see page 16 for detail of what you 
need to download. 

7. Choose No, not this time radio button in Figure 5.4 and then click Next > button. 

 
Figure 5.4 
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8. Then, choose Install from a list or specific location [Advanced] radio button in the menu. 

 
Figure 5.5 

 
9. Click Next > button. 

 
Figure 5.6 
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10. Choose Windows CE USB Devices icon. 

 
Figure 5.7 

 
11. Click Have Disk… button. 

  
Figure 5.8 

 
12. Click Browse… button. Select “wceusbsh.inf” from the folder you created in step 6. 

 
Figure 5.9 
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13. The installation of the driver will start. 

 
Figure 5.10 

 
14. Click Continue Anyway button. 

 
Figure 5.11 

 
15. A menu might be displayed to prompt you to install “wceusbsh.sys”. This happens if 

“wceusbsh.sys” is not in the same folder as “wceusbsh.inf”. Download this file from the CASIO 
Web Site and follow the prompts to specify the location of “wceusbsh.sys”. 
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16. Now the installation of the driver is finished. 

 
Figure 5.12 

 
17. Now go back to the ActiveSync Installation Wizard that you left on the desktop. Click Next > 

button. 

 
Figure 5.13 
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18. Now the connection is established. You can choose either partnership option according to your 

needs. Then click Next > button. 

 
Figure 5.14 

 
19. Now the connection is completed. You can start up Visual Studio and create a program and 

deploy it to the DT-X30. 

 
Figure 5.15 
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5.1.2 If ActiveSync Is Already Installed 
This is the procedure if ActiveSync is already installed on the PC. You just need to let the PC 
recognize the DT-X30 and install the cradle driver as in steps 6 to 16 in Chapter 5.1.1. 
 
1. Navigate to File → Connection Settings…. from the menu in ActiveSync. See Figure 5.16. 

 
Figure 5.16 

 
2. Check Allow USB connection with this desktop computer. USB is available. 

 
Figure 5.17 
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3. On the DT-X30, in Control Panel, choose the PC Connection option. Confirm that PC 

Connection is set to “USB Default”. If not, choose ‘USB Default’ and tap OK button. 

 
Figure 5.18 

 
4. When the DT-X30 is mounted on the USB Cradle, a menu to prompt to install the driver is 

displayed. Follow the same steps in Chapter 5.1.1. 

 
Figure 5.19 
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5.2 USB Connection via Windows Mobile Device Center 
To establish connection via USB interface with PC runs in Windows Vista, use Windows Mobile 
Device Center (“WMDC”). The DT-X30 with the factory-setting (default) does not support the 
WMDC. Follow the procedure below to change the setting on the DT-X30. 
 
Procedure 
1. Close all applications running on the DT-X30. 
2. Navigate to Settings → Control Panel → USB Connection. 
3. Click Connect Utility tab. 

 
Figure 5.20 

 
4. Choose Windows Mobile Device Center radio button and then click OK button. 

 
Figure 5.21 

 
gue asking your final confirmation appears. Click Y
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5. A dialo ES button. 

 
Figure 5.22 
 

-X30 starts up again. 
. Mount the DT-X30 on the cradle, and then follow a message appeared in the WMDC on the 

6. The DT
7

PC. 

 



 

 
Notes: 
• To resume the factory default setting, choose ActiveSync/LMWIN radio button in Step 3 on 

the previous page (see Figure 5.20), and start up the DT-X30 again. 
• The WMDC version 6.1 or later will support the connection establishment via USB interface. 

Any other versions of the WMDC earlier are not interoperable with Windows CE devices 
including the DT-X30 series. 
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5.3 C

1. Choose PC Connection in the Control Panel on the DT-X30. 
2. Set PC Connection to IrDA. 
3. Set the COM port used by ActiveSync on the PC to Infrared Port(IR). 
4. Place the DT-X30 so that the IrDA port located on the bottom of the DT-X30 faces with the IrDA 

port on the PC. Communication can be established if the distance is between zero and 
approximately 1 m. In the case of 4Mbps rate, the maximum distance is approximately 30 cm. 

5. On the DT-X30, from Start menu, navigate to Programs → Communication → 
ActiveSync to start up ActiveSync. 

onnection via IrDA 
f he PC has an IrDA interface, it is possible to connect the DT-X30 to tI  t he PC via IrDA using 

ActiveSync. 
 
Follow the steps below: 
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5.4 Connection via WLAN 
e 2.1 

able models) and PC via WLAN configuration, follow the steps, 1 to 6, below to set up 
 WLAN configuration on the DT-X30. After setting up the configuration, be sure to perform a site 

mmunication via WLAN. 

To establish communication between the DT-X30 with the WLAN module integrated (see Tabl
for the applic
a
survey prior to starting co
 
1. Navigate to Start → S
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ettings → Ctrol Panel → WLANConfig and then click IP tab. 

 
Figure 5.23 

 
Table 5.1 

Parameter Description 
Enable DHCP or Configure IP Determines “Enable” or “Disable” for DHCP. 
IP Determines IP address. 
MASK Determines subnet mask. 
GateWay Determines default gateway. 
DNS1 Determines primary DNS address. 
DNS2 Determines secondary DNS address. 
WINS1 Determines primary WINS address. 
WINS2 Determines secondary WINS address. 

 
If any of the settings in Figure 5.23 is omitted, the process described in the following table will 
automatically take place in the field. 
 
Table 5.2 

Parameter Nothing is set (DHCP) “Configure IP” is set 
Enable DHCP or 
Configure IP 

“Enable DHCP” is assumed. “Configure IP” is set. 

IP Does not determine IP address. Entered address is set as is. 
MASK Does not determine subnet mask. Entered address is set as is. 
GateWay Does not determine gateway. Entered address is set as is. 
DNS1 Does not determine primary DNS address. Entered address is set as is. 
DNS2 Does not determine secondary DNS address. Entered address is set as is. 
WINS1 Does not determine primary WINS address. Entered address is set as is. 
WINS2 Does not determine secondary WINS 

address. 
Entered address is set as is. 

 



 

 
2. Click Basic tab. Set up each param

parameters in Table 5.3. 
eter in the tab by referring to the descriptions for the 

 
Figure 5.24 

 
Table 5.3 

Parameter Description 
SSID Enter the SSID of the network you want to connect to. 

Disable None. 
WEP Open n hentication field.  i  Aut

Security 

WPA PSK in Authentication field (if selected, the Key field must be set also.) 
EAP-PEAP in Authentication field 
EAP-TLS in Authentication field 
Enter 26 (maximum) alphanumeric digits (1 n the Key field if 128 bit 

n i c digits (5 hex pairs) in 
 

 
The field disp hat have been entered. 
***** in the f tracted from the ini file. If ***** in 
the field is ed  Or, if it has never been edited, 
the key extrac as is. 

Key 3 hex pairs) i
radio butto
the Key field

s selected. Or, enter 10 (maximum) alphanumeri
elected. if 64 bit radio button is s

lays the number of characters t
ield implies that the key has been ex
ited, a new key has been deemed to be set.
ted from the ini file becomes effective 

 
 radio button in Auth he EAP-Properties button 

ties screen Description Default 

 EAP-PEAP entication field is selected, click tIf
that appears when selecting the EAP-PEAP radio button to set also the following parameters. 
Table 5.4 

Parameters in 
EAP-Proper
User name Input a user name in alphanumeric (maximum 100 

alphanum
None 

eric). 
Password Input a password in alphanumeric (maximum 100 

alphanumeric). 

ssword has be
*** in the field is 

 set
ac

 
***** in the field implies that the pa en 
extracted from the ini file. If **
edited, a new password has been deemed to be . 
Or, if it has never been edited, the password extr ted 
from the ini file becomes effective as is. 

None 

Domain Input a domain in alphanumeric (maxim
alphanu

um 100 
meric). 

None 

Validate server 
certificate 

 Set up the requisition for server certificate. 
With check mark   : certificate is required. 
Without check mark: certificate is not required. 

Certificate is not necessary
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If EAP-TLS radio button in Authentication field is selected, click the EAP-Properties but

pears when selecting the E
ton that 

ap AP-TLS radio button to set the following settings. 
 
Table 5.5 

Parameters in 
EAP-Properties screen Description Default 

User name Input a user name in alphanumeric (maximum 100 
alphanumeric). 

None 

Certificate Select a client certificate installed already (maximum 
100 alphanumeric). 
 
Search button in the field will display a list of 
installed client certificates. Select one by highlighting 
it. 

None 

Domain Input in alphanumeric (maximum 100 alphanumeric) None 
Validate serv
certificate 

er Set up th requisition for server certificate. 
With check mark   : certificate is required. 
Without check mark : certificate is not required. 

Certificate is required. e 

 
3. Cl  tab. ick WLAN

 
Figure 5.25 

o Description Default 

 
Table 5.6 

Field / Radi
Buttons 

On Enable p tegrated WLAN module. s ower to the in YeAdapter power 
Off od  Disable power to the integrated WLAN m ule. 
Ena le power save mode for the WLAN module. Yes ble EnabPower save 
Disa  mo  ble Disable power save mode for the WLAN dule. 
b p IEEE802.11b standard effect.  Set uStandard 
b/g Set up IEEE802.11b/g standard effect. Yes 
No old level, 

N is practically 
e carried out.   

 roaming Set up “-100 dBm” for roaming starting thresh
a level where communication via WLA
impossible, so that roaming should not b

Def reshold Yes ault Set up “-78 dBm” for the roaming starting th
level. 

RSSI Level for 
initiating roaming 

Hig  thresh el, 
ster (more frequent) roaming 

 h Set up “-72 dBm” for roaming starting
for fa

old lev
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4. Click Detail tab. 

  
F

Table 5.7 
Field / Radio Buttons Description Default 

igure 5.26 
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WLANConfig, 
NetSearch 

- Use only CASIO provided WLAN tool. 
- Configure WLAN setting with settings 

extracted from the ini file. 
- Initiate NetSearch when tapping the icon in 

the task tray. 

Yes 
 

WLAN configure,  
Status display tool

WLANConfig,  
NetUI 

- Use both CASIO provided WLAN tool and 
MS tool. 

- Configure WLAN setting with settings 
extracted from the ini file. 

- Initiate NetUI (MS tool) when tapping the 
icon in the task tray.  

 

 

NetUI/NetUI - Use only the MS tool. 
- Configure WLAN setting, not with settings 

extracted from the ini file. 
- Initiate NetUI when tapping the icon in the 

task tray. 
 
If this radio button is selected and the OK button 
that appears in the subsequent popup warning 
messag other settings in the ini file 
will b ly the WLAN configuration 

 

e is clicked, 
e deleted. On

set with NetUI is saved.  
With check mark : enable the setting.  Enable AdHoc networ ting 

s 
k set

Without check mark : disable the setting. Ye
With check mark : enable the setting.  Enable all authenticat s 

e setting.  es 
ion setting

Without check mark : disable th Y
Inifile comment haracters to be e Enter a comment of up to 100 c

written in the ini file. 
Non

 



 

 
5. If OK button in the popup warning message (see Table 5.7 for description of NetUI/NetUI radio 

button) is clicked, the screen in Figure 5.27 appears. Click OK button to perform a reset on the 
terminal so that the setting takes effect. 

 
Figure 5.27 

 
6 ure rch utility  

 to t click Pi  to check 
that you are connected to the ne

. Check to make s  that the connecti
he Ping fun

on has been established using the NetSea , and
then navigating ction in there. Enter HostName first and then ng

twork correctly. 
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5.5 C
Th gh speed LAN connection on the WLAN non-integrated 
models with HA-G62IO Ethernet cradle. 
 
Follow the steps below: 
1. Connect the dedicated AC adapter to the Ethernet cradle as described in Chapter 4.2. 
2. Connect one end of the network cable to the Ethernet cradle and the other end to the network hub. 
3. Make sure the selector switch on the back of the HA-G62IO Ethernet cradle is set to the position 

“LAN”.  
4. Place the DT-X30 in the cradle and navigate to Start → S

onnection via Ethernet Cradle 
is chapter describes how to establish a hi

ettings → Control Panel → 
Network and Dial-up Connections. 

5. The following screen appears. Double click the AX887721 icon. The icon will not appear unless 
the terminal is placed in the cradle. 

 
Figure 5.28 
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6. The following TCP/IP screen appears. Set up all the p

Servers tabs as required and click OK button. 
arameters in IP Address and Name 

 
Figure 5.29 

 
7. If the connection is established correctly, the icon ( ) in the Taskbar changes to ( ). 
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5.6 
Assuming you have a valid network connection established, you can access shared drives on your 
PC from the File Explorer on the DT-X30. The following shows the steps to initiate this. 
 
1. Configure a network connection on the DT-X30. 
2. Double click My Computer. 
3. Type \\xxxx\ where xxxx is the network name of the PC. 
4. A network logon dialog box will appear. Enter a valid User ID, Password and Network 

Domain. 
5. Any shared network drives on the target PC will be displayed and you will be able to copy files 

freely between them and the DT-X30. 

Accessing Shared Network Drive on Your LAN 
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5.7 Direct TCP/IP Connection from Visual Studio 
If you have a network connection to the DT-X30 (for example, via WLAN or the Ethernet cradle) 
then you can establish a direct link to the development PC without using ActiveSync. 
 
For Visual Studio 2005 
1. Download the files listed below to the DT-X30. 

Accept.exe 

- TcpConnectionA.dll 
 

The source folder in the PC: 
C:\Program Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\armv4i 

The destination folder in the DT-X30: 
\Windows 

 
2. Run ConmanClient2.exe on the DT-X30. 
3. Set the device IP address in Visual Studio 2005.  
4. Navigate to Tools in the main menu of Visual Studio 2005 → Options… → Device Tools 

→ Devices.  
5. Choose DT-X30 Device in the pull-down menu of Devices: and click Properties…. 
6. Click Transport: to access Configure… and set up Device IP address as shown in Figure 

5.30. 

- Clientshutdown.exe 
- ConmanClient2.exe 
- CM
- DeviceDMA.dll 
- eDbgTL.dll 

 
Figure 5.30 

 
7. Run CMAccept.exe on the DT-X30. 
8. Navigate to Tools in the main menu of Visual Studio 2005 → Connect to Device…. 
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9. Choose DT-X30 Device in the list of Devices: and click Connect button

Figure 5.31 if appear indicates the success of connection establishment. 
. The screen in 

 
Figure 5.31 
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6. Set

6.1 Installing CAB Files 
1. After installing the library files, the CAB files in Table 6.1 will be installed in the folder 

below. 
C:\Program Files\CASIO\MBSYS\CAB 

 
Table 6.1 

brary CAB file Preinstalled 

ting Up the Development Environment 

Li
System Library en_SystemLib.ARMV4I.CAB Yes 
Laser Scanner Library en_OBReadLib.ARMV4I.CAB Yes 
Bluetooth Library en_BluetoothLib.ARMV4I.CAB Yes 
Camera Library en_CameraLib.ARMV4I.CAB Yes 
Imager Library en_ImagerLib.ARMV4I.CAB Yes 
WANGPRS Library en_WANGPRSLib.ARMV4I.CAB No 
JPEG library enJPEG.ARMV4I.CAB Yes 
FLINK library en_Flink.ARMV4I.CAB Yes (note 2) 

Notes: 
1. The library with "Yes" in "Preinstalled" column is preinstalled in the DT-X30 and in the 

Device Emulator. Thus, it is not necessary to install it, unless it has been updated or 
changed. 

2. The CAB file, en_Flink.ARMV4I.CAB, in the table does not operate for the DT-X30. Use 
the FlinkLib.dll installed by default in the terminal. 

 
2. Copy all the CAB files in Table 6.1 to any folder on the DT-X30 via ActiveSync. 
3. Carry out each CAB file. 
4. When the installation starts, the installation status will appear. 
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6.2 Visual Studio 2005 
Follow the steps in Chapter 5 “Con
confirm that you can connect to the DT-X30 from

necting the DT-X30 to PC” before checking the steps below to 
 Visual Studio 2005. 

 
1. s
2. Op tudio 2005. 
3. Click the bu e 6.1) to make sure that Visual Studio 

ecognized the connection established with the DT-X30 via ActiveSync. If it does not, 
nc again to establish con

 E tablish connection with the DT-X30 via ActiveSync. 
en the application project for VB or C# in Visual S

tton shown in the red box below (see Figur
2005 has r
start up ActiveSy nection. 

 
Figure 6.1 

 
4. Choose DT-X30 Device in the pull-down menu box. 

 
Figure 6.2 

 
5. You will now be able to deploy solutions and also debug applications on the attached DT-X30 

using the Visual Studio 2005 debugging features. 
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7. Device Emulator 
The Device Emulator provides application developers with an environment that, without having 
the actual terminal available, allows them to debug basic functions and performance of an 
pplication at source level by stepping through the code. 

7.1 S
Th  below before installing the emulator. 
 
• ActiveSync 4.2 or a later version (If required) 

http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

• Visual Studio 2008 or Visual Studio 2005 (Required) 
• CASIO DT-X30 BDK (Required) 
• Standalone Device Emulator 3.0 (Optional. See notes 1 and 2.) 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4
b2f-a394-356e2c2fb114 

 
Notes: 
1. crosoft Device Emulator 3.0, follow the steps below  

T-X30 ExportSDK and Device Emulator of the DT-X30 BDK. 
all it. 
 

C:\Program Files\Windows CE Tools\wce600\DT-X30\Emulation\DT-X30.cdes 
 

Before you change, the default parameter in the file is described as follows. 
module=DevEmu500.exe 

a
 
 

oftware Required 
e Device Emulator requires the software(s) listed

To use Mi
• Install D

.

• Download Microsoft Device Emulator 3.0 and inst
• Edit the following file and save the changes made.

 
Change the parameter to the one below. Be sure to describe the whole parameter in single 
one line. 
module=C:\Program Files\Microsoft Device Emulator\1.0\ 
DeviceEmulator.exe 

 
You can substitute the Device Emulator Version 3.0 released in Visual Studio 2008 for an 

e. engine of Device Emulator included in the DT-X30 BDK by the mentioned procedure abov
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2. If you use Microsoft De

the steps in Note 1 in th
vice Emulator 3.0, you can save the status of the Device Emulator. After 
e previous page, change the settings in "DT-X30.cdes" as follows. 

 Settings\All 

 
Before you change, the parameter in the file is as follows. 
others=/sharedfolder "C:\Documents and
Users\Application Data\CASIO\Emulator\Ctrl" /vmname "DT-X30 
Emulator" 

 
Change the parameter to the one below. Be sure to describe the whole parameter in single one 
line.

 

 
others=/sharedfolder "C:\Documents and Settings\All Users\Application
Data\CASIO\Emulator\Ctrl" /vmname "DT-X30 Emulator" /defaultsave 

 
Case of using after Window

I s Server 2008), please set device 
e trator. 

m opening Explorer. 
(Ex
 

s Vista OS 

f you use OS after Windows Vista (Windows 7 or Window
mulation and I/O simulator as adminis

Please check “Run this program as an administrator” of property fro
. Execute I/O simulator in Windows Vista as administrator.) 

 
Figure 7.1 

 
 
These program have installed the following location as default setting. 
• Device emulator 

C:\Program Files\Microsoft Device Emulator\1.0\DeviceEmulator.exe 
• I/O simulator 

C:\Program Files\Common Files\CASIO\Emulator\DevIoSim.exe 
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7.2 
ft , follow the steps below to start up the 

De
 
1. N -X30. 
2. M e DT-X30 Device Emulator has started up on the screen. See Figure 7.2. 

. Navigate to Start menu → All Programs → CASIO Device IO Simulator and click IO 

4.  that the IO Simulator has started up on the screen. See Figure 7.3. 
5. 

 
Note.  

 Emulator", please execute "Add Device". 
y 

Starting Up the Device Emulator 
A er installing all required software described in Chapter 7.1

vice Emulator on your PC. 

avigate to Start menu → All Programs → CASIO Device Emulator and click DT
ake sure that th

3
Simulator. 
Make sure
If both Figure 7.2 and Figure 7.3 appear on your PC, you are ready to use the emulator. 

If do not appear "DT-X30" in "CASIO Device
If you use OS after Windows Vista, please execute "DevEmuLoader.exe" as administrator b
referring " Case of using after Windows Vista OS" section. 

 
oader.exe  C:\Program Files\Common Files\CASIO\Emulator\DevEmuL

 

  
Figure 7.2  DT-X30 Device Emulator Figure 7.3  I/O Simulator 

bed in this reference manual is a software application that behaves in a very 
si nts or protocols present in 

O ogically integrates application 
programming interfaces (“API”) and certain other functions to allow debugging of the application 
program using external events. The Emulator performs in a pseudo CPU and hardware 

 
 
Terminology of Emulator and Simulator; 
The Emulator descri

milar way to the actual device by imitating individual hardware compone
the actual hardware.  

n the other hand, the Simulator is also a software application that l
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environment and it is impossible for the application to recognize whether it is in the actual device 
rried out by the Simulator are not as 
 mimic them very closely. 

environment or pseudo environment. However, actions ca
alike to those performed by actual components but merely
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sing the Device Emulator 7.3 U

7.3.1 DT-X30 Device Emulator 
The DT-X30 Device Emulator emulates various operations carried out by the actual DT-X30 
device on the PC’s screen such as mouse operation, input on PC’s keyboard, displaying execution of 
applications, and operations by actual devices such as the scanner. Figure 7.4 shows an emulated 
DT-X30 device on the screen of a PC. 

 
Figure 7.4 
 
Key Input 
The emulator offers key input capability similar to that of the actual DT-X30 device. For instance, a 
key on the emulated keyboard of DT-X30 on the screen (see Figure 7.4) can be clicked with the PC 
mouse as well as key input made directly on the PC’s keyboard. 
 
Reading Bar Codes 
The emulator enables bar codes pre-registered in the I/O Simulator (see Figure 7.3) to be input when 
clicking Trigger key on the emulated keyboard (see Figure 7.4). Note however that the Trigger key 
must be continuously pressed for a second or more otherwise an incorrect key input may result. 
 
Sound 
The emulator offers beep and sound capability similar to that of the actual DT-X30 device. 
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7.3.2 I/O Simulator 
The I/O Simulator simulates registration of ba
of terminal being mounted on the cradle.  

r codes, generation of low battery warning, detection 

 
Registration of bar code symbologies 
1. Registration 

Click ADD1D or ADD2D button (circled in red in Figure 7.4) to go into the bar code 
registration mode. 

 
Figure 7.5 

de registration 
 bar code symbology in the Code Type pull-down menu that you wish to register in 

 
. Bar co2

Choose a
the I/O Simulator. 

 
Figure 7.6 
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3. Registration of bar c

Enter bar code data i
ode and note 
n the Code field (see Figure 7.7) and a note about the bar code in the 

Note field if necessary. Click OK button to complete the bar code registration. 

 
Figure 7.7 
 

4. Completion of registration 
After completion of the bar codes registration, the screen in Figure 7.8 shows a list of bar codes 
that have been registered in the I/O Simulator. Prior to debugging with the Device 
Emulator, make sure that you register all bar codes you wish to use in debugging. 

 
Figure 7.8 
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t 5. Editing registered bar code conten

Highlight a bar code in the list of registered bar codes (see Figure 7.8) and click Edit button. 
Figure 7.9 appears for editing the bar code and its information.  

 
Figure 7.9 
 

6. Deleting registered bar code content 

 delete, 
Highlight a bar code in the list of registered bar codes (see Figure 7.8) and click the Del button. 
Dialogue screen in Figure 7.10 appears for you to confirm the deletion. If it is okay to
click Yes button, otherwise click No button. 

 
Figure 7.10 
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 and Low Battery Warning 

If yo e 
simu

Detection of Terminal in Cradle
u check the I/O Box and Low Battery boxes in STATE SETTING field (see Figure 7.11), th
lator simulates the respective events in the emulator.  

 
Figure 7.11 
 

I/O Box 
If this box is checked, a notificati  is issued that the connection between the DT-X30 Device 
E  cradle has been established. This notification can be utilized by the application.   
 
Low Battery 
If this box is checked, a notification that a low battery state has occurred is raised. The icon in the 
Toolbar in the emulated screen appears too. The notification can be utilized by the application to 
recognize the low battery state in the hardware. 

on
mulator and
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Indications 
The I/O Simulator expresses a change of state that occurred in the DT-X30 Device Emulator. 
 
• LED 
When the DT-X30 Device Emulator turns on the LED, the LED icon (LED2) in the I/O Simulator also turns 
on. See Figure 7.11. 
• Vibration 
When the DT-X30 Device Emulator vibrates, the vibration icon in the I/O Simulator also turns on. See Figure 
7.11. 
 

 
Figure 7.12 
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7.3.3 ng via ActiveSync 
 debugging with the Device Emulator is carried out in Visual Studio 2008 or Visual Studio 2005, 

sion/reception of a file with the Device Emulator is carried out, ActiveSync must be 

iveSync 

Connecti
If
or transmis
used. 
 
Setting Act
1. Start up ActiveSync and then navigate to File → Connection Settings …. 

 
Figure 7.13 
 

2. In Connection Settings screen, check in the Allow connections to one of the following 
box and choose DMA in the pull-down menu. See Figure 7.14. 

 
Figure 7.14 
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Connection via ActiveSync 
The way to establish connection of the Device Emulator via ActiveSync is; 

. Right-click DT-X30 Emulator in Available Emulators list and then 
pup menu. See Figure 7.15. 

 
1. Start up the Device Emulator by referring to Chapter 7.2 “Starting Up the Device Emulator”. 
2. Start up Visual Studio 2008 or Visual Studio 2005, and then navigate to Tools → Device 

Emulator Manager
choose Cradle in the po

 
Figure 7.15 

3. tarted up and the  icon in the status bar appears. See the emulated 
 

 ActiveSync has s Make sure
screen of DT-X30 in Figure 7.16. The icon indicates that the connection via ActiveSync has been 
established. 

  
Figure 7.16       Figure 7.17 
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7.4 D

 

Fo
 
Setting Build Configuration 

Choose Debug in the Solution Configurations pull-down menu in Visual Studio 2008 or Visual 
Studio 2005 and DT-X30 Emulator in the target device pull-down menu. See Figure 7.18. 

ebugging Applications 
This chapter describes how to debug your application using the Device Emulator. Before starting 
to “Build”, establish a connection between the DT-X30 and your PC via ActiveSync by referring to
Chapter 7.3 “Using the Device Emulator”. 

r the basic order of developing an application, refer to Chapter 8 “Visual Studio”. 

 
Figure 7.18 
 

Debugging Applications 
• Basic Debug Operation 

The debug operation used for the Device Emulator in Visual Studio 2008 or Visual Studio 
 same as an ordinary debug operation using the actual terminal. 

 

or step-by-step debugging. 
 

1. Navigate to Debug menu → Start Debugging to start up the debugger. 

2005 is the

• Debugging with the Device Emulator 
With the Device Emulator, it is possible to set a break point in the source code of the 
application f

 
Figure 7.19 
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ions with an actual DT-X30, the Device Emulator 

 in red in Figure 7.20) in the source code and step-by-step 
2. Similar to ordinary debugging operat

allows break point setting (circled
debugging. 

 
Figure 7.20 
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8. Visua  S
This cha s application development steps in Visual Studio 2008 or Visual Studio 2005 to 
create an example program. The example program referred to in this chapter is an application 
program developed in three development environments - C++, Visual Basic and C# - using the 
CASIO Common Device Control Library or Common Device Control Class Library. The example 
program for all three environments repeats turning on and off the LED to brink for a period of 5 
seconds. See Chapters 8.1 “Developing in C++”, 8.2 “Developing in VB” and 8.3 “Developing in 
C#” for each development environment. 
 
For the list of the libraries provided by the DT-X30 BDK, refer to Chapter 1.2 “Library 
Configuration”. For detail about each function of the Common Device Control Library and Common 
Device Control Class Library, refer to Common Device Control Library Manual. 
 
The example program in this chapter runs also in the Device Emulator. To use the emulator, rename 
DT-X30 Device to DT-X30 Emulator. 
 
Notes: 
• Functions of the Common Device Control Library which control various individual devices 

integrated in the DT-X30 have different name spaces and names from those available for the 
previous CASIO handheld terminals. They are not compatible with the ones in the previous 

e DT-X7, DT-X11, and IT-600 that use the same libraries. 
• developed with any functions of CASIO dedicated library must be rewritten by 

replacing the dedicated functions with the appropriate functions from the Common Device 
Control Library. 

• Take care when using Visual Studio 2008 or Visual Studio 2005 to upgrade an existing 
application and always keep a backup of your existing project. 

l tudio 
pter describe

CASIO library. The exceptions ar
 Applications 
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8.1 Developing in C++ 

e 
, 

 open Options screen. 
. Navigate to Projects and Solutions → Directories. 

C:\Program Files\CASIO\MBSYS\include 

 the following. 
C:\Program Files\CASIO\MBSYS\lib\ARMV4I 
OK button to close the screen. 

++ 

evice 

This chapter describes necessary steps to develop the example application program (see Chapter 8) 
in C++ environment using the Common Device Control Library. 
Before proceeding to creating the project, check if the installation folder for the Common Devic
Control Library has been registered in Visual Studio 2008 or Visual Studio 2005 by following steps
1 to 8, below. 
 
1. Navigate to Tools → Options … and
2
3. Choose DT-X30 (ARMV4I) in Platforms. 
4. Choose Include files in Show directories for:. 
5. If the installation folder has not been registered, append the following. 

6. Choose Library files in Show directories for:. 
7. If the files have not been registered, append

8. Click 
 
Application Development Procedure 
Subsequent steps show how to create and start up a simple program using one of the system 
u ctions. When running the program, the LED will blink in red for 5 seconds. f n

 
1. First, create Win32 Smart Device Project with its device name DeviceApp for Visual C

in Visual Studio 2008 or Visual Studio 2005. 
2. Choose Pocket PC 2003 in the Selected BDKs field in the Platforms of Win32 Smart D

Project Wizard and click < button. 

 
Figure 8.1 

62 



 

 
3. Choose DT-X30 in the Installed BDKs (SDKs in the screen) field and click > button. 

 
Figure 8.2 

 
4. Click Next > button while DT-X30 is
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 kept being highlighted in the Selected BDKs (SDKs in 
the screen) field. 

 
Figure 8.3 
 
5. Choose Console Application for the Application type in the Application Settings menu, and click 

Finish button. 
6. In Solution Explorer, click DeviceApp.cpp and then append the source code below subsequent 

to “#include <commctrl.h>”. 
 

#include <SystemLib.h> 
#if !defined(_countof) 
#define _countof(_Array) (sizeof(_Array) / sizeof(_Array[0])) 
#endif 

 



 

 
7. Append the source code below in the main function of DeviceApp.cpp. 

    DWORD result; 
    TCHAR msg[16]; 
 
    result = SysSetLED(LED_RED, 5, 8, 8); 
 
    if(result == TRUE) 
    { 
        result = SysGetLED(); 
        switch(result & 0x0000000F) { 
        case LED_OFF: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_OFF") ); 
            break; 
        case LED_RED: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_RED") ); 
            break; 
        case LED_GREEN: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_GREEN") ); 
            break; 
        case LED_ORANGE: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_ORANGE") ); 
            break; 
        case LED_BLUE: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_BLUE") ); 
            break; 
        case LED_CYAN: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_CYAN") ); 
            break; 
        case LED_MAGENTA: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_MAGENTA") ); 
            break; 
        default: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_UNKNOWN") ); 
            break; 
        } 
        MessageBox(NULL, msg, TEXT("LED"), MB_OK); 
    } 
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8. Choose Properties in the Project of Visual Studio 2008 or Visual Studio 2005, and navigate to 

Configuration Properties → Linker → Input → Additional Dependencies and then 
app ed circle in Figure 8.4). end SystemLib.lib (see r

 
Figure
 
9. Ch arget Device to establish connection with the PC. 

10. Ch bugging 
or . 

11. Th d to the “\Program Files\<name of project>” folder by default 
in t

12. Ch  correctly on the DT-X30. 

 8.4 

oose DT-X30 Device for the T
oose Debug in Visual Studio 2008 or Visual Studio 2005 and then click either Start De
Start Without Debugging
e project will be built and copie
he DT-X30.  
eck that the program runs
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8.2 
ple application program (see Chapter 8) 

in VB environment using the Common Device Control Class Library. 
 
Application Development Procedure 
Subsequent steps show how to create and start up a simple program using one of the system 
functions. When running the program, the LED will blink in red for 5 seconds. 
 
1. Create a new VB Smart Device Application in Visual Studio. 
2. In Solution Explorer, right-click References and click Add Reference… 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click it to open. Click OK button. 

Developing in VB 
This chapter describes necessary steps to develop the exam

 
Figure 8.5 
 

4. Add a button to the form, rename it LED, and double click it. 
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5. In the event function for the 

Dim result As Int

button to click, add the following code. 
32 

Dim msg As String 
 
result = Calib.SystemLibNet.Api.SysSetLED( _ 
            Calib.SystemLibNet.Def.LED_RED, 5, 8, 8) 
 
'.NET vales of “true” and “false” are “-1” and “0” respectively. 
If result = -1 Then 
    result = Calib.SystemLibNet.Api.SysGetLED() 
    Select Case (result And &HF) 
        Case Calib.SystemLibNet.Def.LED_OFF 
            msg = "LED_OFF" 
        Case Calib.SystemLibNet.Def.LED_RED 
            msg = "LED_RED" 
        Case Calib.SystemLibNet.Def.LED_GREEN 
            msg = "LED_GREEN" 
        Case Calib.SystemLibNet.Def.LED_ORANGE 
            msg = "LED_ORANGE" 
        Case Calib.SystemLibNet.Def.LED_BLUE 
            msg = "LED_BLUE" 
        Case Calib.SystemLibNet.Def.LED_CYAN 
            msg = "LED_CYAN" 
        Case Calib.SystemLibNet.Def.LED_MAGENTA 
            msg = "LED_MAGENTA" 
        Case Else 
            msg = "LED_UNKNOWN" 
    End Select 
    MessageBox.Show(msg, "LED") 
End If 

 

se offer you suitable options as 
appropriate. If you do not, make sure you review steps 1 to 5 to make sure you have added the 
reference correctly. 

 
6. Initiate ActiveSync to establish connection between the DT-X30 and PC. 
7. Choose Deploy <name of project> on Build menu. 
8. The project will be built and copied to the DT-X30. By default, it will be copied to \Program 

Files\<name of project> folder. SystemLibNet.dll will be deployed to the same folder. 
9. Check that the program works correctly on the DT-X30. 
 
You can also use the CASIO samples as described in Chapter 1.4. 

Note:  
If you type this code manually you should see the IntelliSen
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8.3 
This c  steps to develop the example application program (see Chapter 8) 
in C#
 
App
Subse
functi
 
1. Cr
2. In  Reference… 
3. Cli  the CASIO .NET library files. 

Hi . 

Developing in C# 
hapter describes necessary

 environment using the Common Device Control Class Library. 

lication Development Procedure 
quent steps show how to create and start up a simple program using one of the system 

m, the LED will blink in red for 5 seconds. ons. When running the progra

eate a new C# Smart Device Application in Visual Studio .NET. 
Solution Explorer, right click References and click Add

 where you have storedck Browse and navigate to the folder
ghlight SystemLibNet.dll and click Open. Click OK button

 
Fig
 

4. At

ure 8.6 

 the top of your source file add the following code.  
using Calib; 
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5. Add a button to your form, renam

Int32 result = ne

e it LED and double click it and then add the following code: 
w Int32(); 

string msg; 
 
result = SystemLibNet.Api.SysSetLED(SystemLibNet.Def.LED_RED, 5, 
8, 8); 
 
// .Net values “true” and “false” are “-1” and “0” respectively. 
if(result == -1) 
{ 
    result = SystemLibNet.Api.SysGetLED(); 
    switch(result & 0x0000000F)  
    { 
        case SystemLibNet.Def.LED_OFF: 
            msg = "LED_OFF"; 
            break; 
        case SystemLibNet.Def.LED_RED: 
            msg = "LED_RED"; 
            break; 
        case SystemLibNet.Def.LED_GREEN: 
            msg = "LED_GREEN"; 
            break; 
        case SystemLibNet.Def.LED_ORANGE: 
            msg = "LED_ORANGE"; 
            break; 
        case SystemLibNet.Def.LED_BLUE: 
            msg = "LED_BLUE"; 
            break; 
        case SystemLibNet.Def.LED_CYAN: 
            msg = "LED_CYAN"; 
            break; 
        case SystemLibNet.Def.LED_MAGENTA: 
            msg = "LED_MAGENTA"; 
            break; 
        default: 
            msg = "LED_UNKNOWN"; 
            break; 
    } 
    MessageBox.Show( msg, "LED"); 
} 

 
Note: 
If you add this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not see this, then review steps 2 to 4 in the previous page to make sure you 
have not made a mistake. 
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6. Initiate ActiveSync to establish connection between the DT-X30 and PC. 
7. Se enu. 
8. Th uilt and copied to the DT-X30. By default, it will be copied to \Program 

Files\<name of project> folder. SystemLibNet.dll will be deployed to the same folder. 
9. Ch
 
You c  also use the CASIO samples as described in Chapter 1.4. 

lect Deploy <name of project> on Build m
e project will be b

eck that the program works correctly on the device. 

an
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9. 
r 

ul web 
ry manuals on 

Resources 
Microsoft’s own http://msdn.microsoft.com/mobility/ is an extremely comprehensive resource fo

ogrammers targeting WindowsCE .NET based devices. It includes links to most other usefpr
based resources. You will find detailed Software and Libra
http://world.casio.com/system/pa. 
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